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Introduction

Introduction
Glink is a terminal emulator designed for general-purpose communications
work. Glink, Professional edition and Glink, Enterprise
edition are Window 32-bit versions, supporting all the current versions of
Windows and Windows NT. Windows 16-bit, DOS, MAC and Java versions of
Glink are also available as separate packages. For more details on Glink
functionality, refer to the User's Guide, for details on Glink configuration, refer
to the Administaror's Guide.
This Glink Release Notes document is intended for system and network
administrators and covers what's new in this release and previous releases.
Please read these notes.
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Introduction

Warranty
While Gallagher & Robertson A/S have made every effort to ensure that this
software package should function as described, no warranty of any kind, express
or implied, is made by us. Gallagher & Robertson A/S shall not be liable for any
damages, direct, indirect, special, or consequential arising from a failure of this
program to operate in the manner desired by the user. Gallagher & Robertson
A/S shall not be liable for any damage to data or property that may be caused
directly or indirectly by the use of this program. In no event will Gallagher &
Robertson A/S be liable to you for any damages, including lost profits, savings
or other incidental or consequential damages arising from your use or inability to
use the program, or for any claim by any other party. Any dispute arising in
connection with this warranty will be settled under Norwegian law.
Gallagher & Robertson A/S confirm their intention that the software should
function as described, and will make all reasonable efforts to ensure that errors
in the software reported in writing to our office in Oslo be corrected in future
releases of the software.
Gallagher & Robertson A/S grant you as a registered user of Glink a licence to
use the software and to make those copies you deem necessary for your own
security. The package itself remains the property of Gallagher & Robertson A/S
and we expect you to take all reasonable precautions to ensure that illegal copies
are not made by a third party.

Support
Support is available from your local supplier rather than from Gallagher &
Robertson A/S. For information about support numbers check the information
screen in the program itself. This screen can be displayed from the Glink menu
bar (Help/About Glink).
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What’s new (8.3)

Release notes
What's new
What's new in Glink 8.4
Windows 8
Glink 8.4 has been certified by Microsoft as being compatible with Windows 8.
Accordingly it does not warn that it's being run on an unsupported OS. Earlier
versions of Glink issue the warning on Windows 8. We strongly recommend that
all Glink users intending to upgrade to Windows 8 also upgrade their copies of
Glink to 8.4 or later.
We have verified that Glink 8.4 handles all relevant touch gestures provided by
Windows 7 and Windows 8.

Internet lookup
A new internet lookup functionality has been added to the context sensitive
menu (the menu shown when the Glink page is right-clicked). This lookup
function takes the text you've marked on the Glink screen and feeds it to a choice
of several social media and search engines. For example you can mark an
address and feed it directly into Google maps. Or you can mark a name and look
it up directly in Facebook.

User distribution enhancements
Script files using the .scr extension contained in a package build for user
distribution are renamed to use .scrgl as part of the install process. This behavior
can now be overridden by specifying NOSCRGL as a command in the
PACKING.LST file.
The uninstall program GLUNINST that performs uninstall for user-built
distribution packages now also uninstalls the Glink license and also deactivates
it if it has been activated.

Gallagher & Robertson
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What’s new (8.3)

The uninstall program can be run in silent mode (using /SILENT as a command
line option) for use with unattended uninstalls.

Script enhancements
A new script command FNDEXEC can be used to find the full path to the
executable that is associated with the file type of the specified file name.
A new script command FVERSION provides version information for the
specified executable file.

Miscellaneous enhancements
The Ggate interface now supports NVT as a known terminal type.

Fixed problems
The following known errors have been corrected in this release:
E1246: Glink, 'format with tabs' paste could add characters
E1247: Glink, disconnect was not detected
E1248: Glink, VIP7700 overflow from transmit in last line
E1249: Glink, DKU, key press displayed after overflow
E1250: Glink, screen switch from 132 to 80 lost maximize
E1251: Glink, license server parameters not saved
E1252: Glink, uninstall could fail to release license

What was new in Glink 8.3?
In addition to fixes for all currently known errors, the following new features
and corrections have been added since the 8.2.0 release of Glink Professional
edition and Glink Enterprise edition (see also: What was new in release 8.2.

Activation and check for updates
Activation licenses are now stored as glicense.MACHINENAME.txt files,
enabling use of activation on systems where Glink resides on a file or terminal
server without conflicts between the various client workstations.

4

Glink Release Notes

Gallagher & Robertson

What’s new (8.3)
The activation process has been streamlined and now provides more information
to help track down potential problems. At activation time an additional
information box is displayed with information about the activation, and which
also allows you to open the text version of the license with notepad for printing
and/or saving the license. Printing and/or saving may also be done later using
new buttons in the Help->About Glink dialog box.
Glink can check for upgrades to the software that have been made available on
the G&R server. If you are eligible for the upgrade under your support
agreement then you will also be given the option of downloading the new
version immediately, otherwise you will just be informed that the new version
has been released. This checking is controlled by the ‘check for updates’ box in
Settings -> General. Sites with a large number of users may wish to disable this
option and only enable it for the system administrator; this may be done using
the normal locking option.
Deactivation is performed automatically when Glink is uninstalled, thus freeing
up the license for immediate use on another workstation (this requires that the
workstation uninstalling Glink has Internet access). Problems with deactivation
are reported locally with the information required for G&R to update the license
database manually.
Deactivation of a single workstation in a shared environment where Glink
resides on a file or terminal server can now be done without uninstalling Glink
(which would uninstall for all workstations), using the deactivate button in the
Help->About Glink box.

Command line options
/ACT xxxx-xxxx-xxxxx-xxxx can be used on the command line to supply your
activation key in advance. If this option is used then activation will be performed
silently (if necessary) when Glink is started up.

General emulation
Glink now no longer changes the font size when the host switches between 80and 132-column modes, but instead changes the window width to accommodate
the change. You can revert Glink to its previous behaviour using the CFIX 3827
1 script command.

VT emulation
A large number of improvements have been made to the VT emulation,
supporting a larger set of VT-240 commands and status reports.
Gallagher & Robertson
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What’s new (8.3)
Support has been added for the DEC technical character set.
DEC NRC (National character replacement) character sets are supported
directly. You can suppress interpretation of NRC commands using the script
CFIX 3826 1 script command.
Display of DEC special graphics has been greatly improved when Windows
fonts have been selected.

Operating systems
Windows 7 and Windows 2008 Server R2 are recognised and reported as
supported operating systems, and 64-bit versions are also reported as such.

Telnet keepalive
Keepalives are now supported for telnet connections, both standard connections
and those using PuTTY.

Unicode entry
When Glink is running in Unicode mode entry of many accented and special
characters may be done using a new dialog box. This box is invoked by default
with the Ctrl+F12 key.

Help files on a server
If the help files reside on a server then newer versions of Windows will often
refuse to access these, considering them to be a security problem. Glink now
avoids this situation by making a local copy of the help files and using this local
copy instead.

Help for Windows 7 and Windows 2008R2
Microsoft have made Windows help available for both these operating systems
and although these are not redistributable Glink will now connect directly to the
Microsoft download page if these versions are needed.

Script commands
SET SSHD script commands have been renamed to SET SSH, and the SET
PKEY command changed to SET SSH PKEY. The old formats are still
supported for compatibility.
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What’s new (8.3)
There is a new command ISSERVICE which can be used to tell Glink that it has
been set up as a service. This is required for correct display of dialog boxes.

Ggate/DGA debugging
Debugging for the G&R/Gate and G&R/DGA interfaces is now controlled by
two new checkboxes in the setup dialog rather than by including –S_ and/or –D_
as additional parameters.

Gallagher & Robertson

Glink Release Notes

7

What’s new (8.2)

What was new in Glink 8.2?
Glink 8.2 contains all corrections to known errors that have been recorded to
date. The major reason for producing a new release at this time is to provide a
version that has been qualified for the new Microsoft Windows 7 product.

Windows 7 qualification and approval
This release has been qualified on the 64-bit and 32-bit versions of Windows 7
and has been certified under the Microsoft "Compatible with Windows 7" logo
program.
Glink Help on Windows 7
Microsoft has not so far made their Windows 7 version of WinHlp32.exe
available for download. Users should check the Windows download site for
more information. When the new version is available Glink will be updated to
point to it.

Windows Server 2008 qualification and approval
This release has been qualified on the 64-bit and 32-bit versions of Windows
Server 2008 and has been certified under the Microsoft "Works with Windows
Server 2008" logo program.

New functionality
Full Unicode / UTF-8 emulation
For VIP7800, ANSI and VT-xxx emulations Glink will now support full
Unicode for the internal screen image. This support presupposes UTF-8 for host
communications.
Facelifting options
Screen => Colour Adjustments => Two-tone background colour allows you to
configure a two-tone striped background making it easier for the eye to track
lines in a form.
New facelifting options have been added for restricting the area in which Glink
searches for on-screen pushbutton texts. This applies to both Screen=>
Facelifting => Pushbuttons and Screen => Facelif t=> Pushbuttons => Custom
pushbuttons.
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What’s new (8.2)
Screen => Facelift => Pushbuttons => Custom now allows you to define the
texts used on the pushbuttons.
The SET BUTTON FONT script command also sets the on-screen pushbutton
fonts.
Drag and drop
You can now drag and drop texts into the Glink emulation window.
TN3270 dynamic model
An option has been provided defining the TN3270 dynamic model terminal type
that allows you to specify the emulation screen size for the alternate model
New Glink functions
The following new Glink functions are available:
Add button on marked
Copy paragraph
Cursor block
Cursor blink
Cursor disable
Cursor enable
Cursor line
Edit/Paste block
Zoom
Zoom in
Zoom out

Adds a pushbutton for the marked screen area, default
assignment is on the context menu (right mouse click).
Copies multiple lines to clipboard without CRLF
between lines.
Sets block cursor.
Sets blinking cursor.
Turns off the cursor.
Turns on the cursor.
Sets line cursor.
Paste as block, default assignment is on the context
menu (right mouse click).
Changes the font and window size. Default
assignment is on the status line.
Increases the font and window size.
Decreases the font and window size.

FTP improvements
Drag and drop
You can now drag and drop files and directories into the GlinkFTP local or
remote file list windows.
Show remote hidden files
This option allows you to see UNIX/GCOS hidden files that start with a dot such
as ‘.profile’.
Gallagher & Robertson
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What’s new (8.2)

Script enhancements
The following new commands and variables are available:
SET SSHD PASSWORD
SET SSHD SERVER
SET SSHD USER
$SSHPASS
$SSHSERVER
$SSHUSER

10

sets the password for SSHD
sets the server name for SSHD
sets the user name for SSHD
Provides the configured SSHD password
Provides the configured SSHD server name
Provides the configured SSHD user name
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What was new in Glink 8.1?
The following new features and corrections have been added since the 8.0.0
release of Glink Professional edition and Glink Enterprise edition (see also:
What was new in release 8.0):

Windows Vista qualification and approval
This release has been qualified on the 64-bit and 32-bit versions of Windows
Vista and has been certified under the Microsoft "Certified for Windows Vista"
logo program.

New functionality for Windows Vista
MSI Installation
The Glink SETUP deliveries are now Microsoft Windows Installer MSI
packages supporting 'per user' or 'all users' (default) installations. The packages
also provide for administrative (silent) installations.
Security
Glink supports UAC (User Account Control), concurrent user sessions and fast
user switching scenarios. All executables are delivered with a digital signature
and, with the exception of the license upgrade utility (GSTAMP.EXE), contain
the program manifests for 'asInvoker' execution level (no elevated privileges
required).
Default Glink directories
For Windows Vista UAC (User Access Control) requirements, Glink
configuration
directories
/U
and
/CD
now
default
to
the
%MyDocuments%\Glink and %CommonDocuments%\Glink or GlinkExecDir
directories.
The default Glink directories are:
Per user:
GlinkExecDir
ConfigDir (/CD)
UserDir (/U)

Gallagher & Robertson

%LocalAppData%\Apps\Glink Professional
% CommonDocuments%\Glink or GlinkExecDir
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What’s new (8.1)
All users:
GlinkExecDir
ConfigDir (/CD)
UserDir (/U)

%ProgramFiles%\Glink Professional
%CommonDocuments%\Glink or GlinkExecDir
%MyDocuments%\Glink

For details on the actual locations of these directories, refer to the Directories
used by the emulator and Windows platform directory locations sections.
IPv6 support
Support for IPv6 has been added for all TCP/IP intefaces. IPv6 addresses can be
supplied in IPv6 formats or as DNS names.
Vista menus
Glink has been updated to display Vista themed menus.
Vista/XP style variable fields
When available, edit control visual styles are used to display unprotected fields
in the emulations, instead of using the 3D look.
Administration
The Glink setup program requests Vista admin rights when installing.
Glink Help on Vista
Microsoft has now made their Vista version of WinHlp32.exe available for
download from:
http://www.microsoft.com/downloads/details.aspx?familyid=6ebcfad9-d3f54365-8070-334cd175d4bb&displaylang=en
If the updated WinHlp32 is not available on the Vista workstation, then Glink
will prompt the user to collect the new version from this location the first time
help is accessed.

New product
Glink Enterprise Edition includes GlinkWeb and GlinkAPI for .NET and Java
platforms. NOTE that the GlinkWeb COM+ is deprecated and replaced by these
versions.

12
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Glink Enterprise Edition
Glink Java/.NET license server: the Glink Enterprise Edition now supports
sharing session licenses with the Java and .Net versions of Glink and GlinkWeb
by using /CS or /CSSL instead of the /LS command line option.
GlinkWeb: the ASP version of GlinkWeb (Glink in Web mode) has been
deprecated and Glink Enterprise Edition customers should upgrade to the new
GlinkWeb .NET version.

New functionality
Start up with a configuration list
The /C * command line option can be used to display an initial list of available
configurations.
Wallpaper selection
The wallpaper file selection lists are preinitialized with all installed images in the
Glink directory. The facelifting dialog also supports 'preview browsing' by
immediately displaying the selected background and display options in the Glink
window.
UTF-8
Support for UTF-8 encoding for transmission/reception has been added for all
host communications.
PuTTY SSHD interface
The plink.exe module delivered with Glink has been enhanced to allow sending
a ‘break’ to the host or do dynamic terminal resizing when using the PuTTY
SSHD interface.
TN3270/5250 automatic print session
An option has been provided for specification of a printer LU or device name for
TN3270 and TN5250 connections.When this is specified an additional printer
session will be started automatically alongside of the normal screen session.
Keyboard transliteration texts
Glink 7/8-bit transliteration files can now be configured with a text description,
default texts are applied to the delivered glwink.* files.

Gallagher & Robertson
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What’s new (8.1)
Configuration wizard
A new 'wizard' guides you through the initial configuration options when
starting Glink for the first time or using the Settings->New... option.
Color adjustment
The color adjustment dialog box has been redesigned and uses the standard
Windows color dialog box to select the colors.
Spread font to fit window
If you are using an emulation that allows the host to switch the screen size, for
example IBM3278-4 (which can switch between 24 and 43 lines), then this
option in the Settings=>Screen=>Font dialog box can be turned off to stop Glink
spreading the font, and instead keep its normal size and center it in the Glink
window.
Initial window length
The initial length of the Glink window to be used at startup time can now be
preconfigured in Settings=>Screen=>Window attributes, making use of the /Rnn
command line option or SET SCREEN LENGTH nn startup script command
redundant.
Custom on-screen push buttons
Enhancements
have
been
added
to
the
on-screen
Settings=>Sceen=>Facelifting=>Custom buttons to allow wildcard character
searching.
Configurable Glink title
An option has been added in Settings=>General to allow you to configure the
Glink title bar text.
Minimize to tray
An option has been added in Settings=>Screen=>Window attributes to tell Glink
to minimize to the taskbar tray status area.
IND$FILE enhancements
The IBM IND$FILE host command is now configurable, allowing user-written
CICS transactions to do file transfers. Transliteration for IND$FILE ASCII
transfers can be configured by customers transferring files in various character
sets
14
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What’s new (8.1)
IBM 3270 keyboard functions
Many new 3270 keyboard functions have been added to allow keyboard
configurations to be similar to other 'industry standard' 3270 keyboards:
forward/backward/delete word, attribute commands, fast cursor move
commands, cursor shape selection.
IBM color enhancements
A number of enhancements have been made for color support in IBM
emulations: 3270 color emulations now support setting background colors,
default low intensity colors are more readable, black background is the default
for 3270/5250 emulation modes.
IBM 3270 transparent PCL print
Support has been added for direct host transparent printing and will
automatically switch to Windows (text) print mode if necessary, allowing
Windows (GUI) printing to be configured for normal host line printing.
IBM 5250 'host print transform' for transparent print
Support has been added for 'host transform' transparent printing and will
automatically switch to Windows (text) print mode if necessary. Device
information options for configuring 'host print transform' have been added to the
TN5250 configuration.
Enhanced VIP7800 Capture mode
The File=>Capture functionality has been enhanced in VIP7800 mode to insert
CRLF when the host changes line by cursor positioning commands.
Quality of Service (QoS)
A Quality of Service (QoS) option is added to allow you to select any of the
QOS templates available on the workstation.

Script enhancements
The following new commands and variables are available:
EXTRACT
FIND
MVSCROLL
RCVTURN
REPLACE
Gallagher & Robertson

extracts a numbered parameter from a delimited string
finds a specified string in the screen
moves and resizes the scrollback window
waits for turn
replaces occurrences of one string with another
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What’s new (8.1)
SET ALTERNATE sets the alternate server name
SET TRCWIN
controls display of the extra script debugging window
TRACE
enhanced to only show script trace window when
TRACE is executed
TRIM
strips leading and/or trailing spaces and control
characters
$CFGCHANGED Indicates if the current configuration has been modified
$FNDX
Used with FIND, returns column of string found
$FNDY
Used with FIND, returns row of string found
$GLCFG
Name of GLINK configuration directory
$LANGUAGE
Language key for program texts

Command line options
/C *
/CS dnsname
/CSSL dnsname

Displays list of available configurations, *.glinkconfig
Glink Java/.NET license server DNS name (port 30842)
Glink Java/.NET SSL license server DNS name (port
30852)
/LB dnsname1,dnsname2 DNS name list of the Glink license backup
servers
The following default directory locations have changed:
/CD c:\dir
/U c:\dir

Specify name of configuration directory
(%CommonDocuments%\Glink or GlinkExecDir)
Specify name of user file directory
(%MyDocuments%\Glink)

FTP improvements
File info tips
When hovering the mouse over a filename, they display more detailed
information about the file including the actual LIST text returned by the FTP
server.
Recursive directory upload and download
You can now select a directory for upload or download with GlinkFTP.
Symbolic files and directories
GlinkFTP now distinguishes between symbolic files and directories.

16
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What’s new (8.1)
Filename conversion options
GlinkFTP can: convert between spaces and underscore, convert to upper case,
convert to lower case or capitalize the name. It can also replace the extension
automatically when transferring the file.
Create directory
A right mouse menu option has been added for creating directories.

Gallagher & Robertson
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What’s new (8.0)

What was new in Glink 8.0?
The following new features and corrections have been added since the 7.2.0
release of Glink Professional edition and Glink Enterprise edition (see also:
What was new in release 7.2):

New Glink look
New Icons
For the first time since the release of Glink for Windows in 1992, Glink has
acquired new icons as have GlinkFTP, Glink Forms Assistant and Glink License
server.
New Toolbar images
For the first time Glink and GlinkFTP have also acquired new toolbar images.
Over 100 new icons have been added to Glink to give it a full new XP look and
feel. These icons are used in the Glink toolbar, menus and dialog boxes. For a
full list of the available images and their default function association you may
refer to the Glink function list section of the on-line help.

New platforms
This release has been qualified on the 64-bits version of Windows 2003 and
Windows XP. This allows you migrate your users to powerful Intel Itanium
servers running Windows 2003 Terminal Server or to take advantage of
powerful 64-bit workstations from AMD.

New product
GlinkVisual and GlinkVisual Forms Assistant
This release of Glink Professional Edition includes support for the first release
of the GlinkVisual Forms Assistant, to assist you in developing Visual Basic
applications to facelift your mainframe application screens. The GlinkVisual
Forms Assistant is a separately priced product needed by developers. The
runtime support is included in Glink Professional Edition and Glink Enterprise
Edition, and needs no additional user license, other than a Glink Professional
Edition or Glink Enterprise Edition license.

18

Glink Release Notes

Gallagher & Robertson

What’s new (8.0)
GlinkVisual is a replacement for GL.Visual, a product developed by another
software house and now discontinued and unsupported. GlinkVisual can also
replace Net.Visual and EYESYS. There is very little conversion effort needed,
and our distributors offer conversion packages that include some or all of the
conversion (depending on price).

New facelift tool
GlinkWeb Forms Assistant
GlinkWeb (Glink in Web mode, run on a Web server and accessed from
browsers) automatically converts mainframe application screens to HTML on
the fly, so that your users can access the applications from a browser. The
conversion automatically facelifts the screens to some degree, but you can gain
considerable extra functionality for your browser users by investing in some
custom facelifting. This release of Glink Enterprise Edition includes the first
release of the GlinkWeb Forms Assistant, to assist you in building ASPs (Active
Server Pages) to facelift your mainframe application screens for viewing from a
browser.

New functionality
Integrated Graphical keyboard configuration window
You configure your Glink keyboard layout using a friendly graphical interface
(GUI) in a single configuration window. The Glink emulation window is
updated with your configuration changes dynamically as you make them. A
Keyboard pane in the configuration window displays a keyboard diagram that is
modified to match the keyboard you are actually using. A Functions pane
displays a function tree with every Terminal function, Glink function, Macro,
Script, Menu shortcut, Configuration dialog box, and Character known to Glink.
This functionality is accessed from:
Settings / Keyboard
You can select key combinations for configuration by clicking them in the
keyboard diagram, or by pressing the keys on the keyboard. The basic mode of
operation is that you expand the function tree in the Functions pane to reach the
function you would like to configure, and then drag it to the Keyboard pane and
drop it on the key where you would like the function. There is a separate group
with tabbed panes for the Function bar, the Keyboard bar and the Menu setup.
You can configure each of these in the same way by dragging a function from
the Functions pane, and dropping it onto the item where you would like the
function.

Gallagher & Robertson
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What’s new (8.0)
Macro limitations removed
To maximize the functionality of the keyboard configuration GUI the macro
capability has been dramatically increased. You can configure up to 1000
different macros, each of which may be as long as available memory permits.
There is no upper limit on the total length for all macros, again memory
permitting.
Integrated graphical transliteration table generator
Configuration of the transliteration tables used to transliterate character set
between PC< / mainframe has been moved to the emulation configuration dialog
box:
Settings / Emulation / Transliteration
A "Configure" button takes you to a dialog box that lets you modify the
transliteration table or build new ones.
Text to button (hot spot) conversion extensions
The facility for pre-configuring screen texts for conversion to buttons has been
extended from detecting only strings such as 'Fnn', 'PFnn' etc. to allow you to
configure any text you might receive from the mainframe for automatic
conversion to a button. Each text you configure is associated with a macro that
can use any of the normal macro functions, including execution of script
commands. This functionality is accessed from:
Settings / Screen / Facelifting / Custom
Language extensions
Support has been provided for use of the Arabic character set. Glink uses ANSI
Arabic (code page 1256) internally, as do other Windows applications.
Mainframes normally use ASMO (code page 708) for transmission over the line,
and Glink includes a transliteration file (GLWINK.ARA) that implements this.
You select the transliteration table in:
Settings / Emulation / Transliteration
As for the other Windows character sets, you configure Arabic in:
Settings / Screen / Fonts / Character set
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What’s new (8.0)
The Bull DKU emulation has been extended to support Arabic, using the
standard Bull character set (C114) on the GCOS7 mainframes. C114 is ASMO,
and needs the GLWINK.ARA transliteration.
The IBM emulations have been extended to support all of the double-byte
character set (DBCS) languages: Japanese (using SHIFT-JIS locally), Chinese
Simplified (using GB2312 locally), Chinese Traditional (using Big5 locally) and
Korean (using Hangeul locally). All you need to do is install the standard
Windows National Language Support for the languages in which you are
interested.
SSH (Secure Shell) extensions
In addition to being available as a separate Communications Interface, Plink is
now available transparently from all the TCP/IP interfaces.
That means that you can run a Ggate, TNVIP, TN3270, TN5250, Telnet or
Rlogin session with SSH. Glink automatically and transparently starts the
PuTTY interface and dynamically sets up SSH port forwarding for your
connection. This is far easier for you than the static and complicated port
forwarding configuration offered by PuTTY. You can set up a single SSH
system to act as a secure gateway for all of your internal mainframes, whether
they be Bull, IBM, UNIX or Linux. Note that Glink FTP can now use SSH port
forwarding, so that your SSH system can also act as a secure front-end for all
your FTP transfers.
Comms interface
The Comms interface dialog box has been simplified and enhanced to allow you
to select the TCP/IP protocol you require directly.
New Communications protocol for Bull users
The new G&R/DGA (Direct GCOS Access) interface allows you to connect to
Bull mainframe systems using either DSA or DIWS protocols over TCP/IP,
without the need for a Ggate (or TNVIP) intermediate server or front-end
system. DGA is a full-scale implementation of DSA/DIWS. It handles both
DSA200 (accessing GCOS 7) and DSA300 (accessing GCOS 8 and GCOS 6).
The DSA300 protocol includes all CXI options for accessing TP8.
Unified File Transfer
The Bull UFT (Unified File Transfer) protocol has been added to the set of file
transfer protocols supported by Glink when it is using the new DGA (Direct
GCOS Access) protocol:
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Transfers / File transfer menu
IBM 3270 graphics extensions
A number of enhancements have been made for graphics displayed in 3270
mode:
Display of graphics screens has been speeded up by displaying the graphics as
they are received rather than waiting for the entire screen.
Graphics are displayed at a size that suits the current screen size. However, if
you resize the Glink window, Glink will now resize the graphics along with the
window.
Full support for printing and copying graphics to the clipboard is provided.
Some minor changes to the way in which colors are displayed provide better
compatibility with IBM's Personal Communications.
Additional predefined color schemes have been provided both for screen color
mapping and printer color mapping.
IBM 3270 APL support
The IBM 3270 terminal was available with an option for display and entry of
APL symbols for programmers using that language. This support is now built
into Glink. Glink uses the same keyboard layout as the original terminal and
IBM's Personal Communications package.
Display of APL characters from the host is automatic. APL keyboard entry mode
is toggled on and off using the Ctrl+F8 key. For real usability in entry mode a
keyboard overlay (or a real APL keyboard) is desirable. The font needed for
APL display is provided as part of the standard Glink delivery.
Simplified transition to Glink for 3270 users
In this release we deliver keyboard layout files that simplify your migration from
other 3270 terminal emulation packages to Glink. From the new graphical
keyboard configuration interface you can load keyboard layouts offering the
same 3270 keyboard functions and mappings that you are used to from IBM
Personal Communication, NetManage RUMBA, WRQ Reflection or Attachmate
EXTRA!
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ANSI SCO keyboard layout
This release of Glink offers a new ANSI SCO keyboard layout file that is 100%
compatible with the SCO function key mapping used both on SCO UNIX
systems and on all major Linux distributions.
Script trace window
The script command 'Trace' now starts a trace window that displays the source of
the script, highlighting each command as it executes. An optional parameter to
'Trace' supplied a delay in tenths of a second to be applied between each script
command, in order to make it possible to follow what happens in the trace
window.
Script trapping of Double-click
If you set up an 'ON KEY' trap for single-clicks (MLEFT, MRIGHT,
MMIDDLE), you can set up an additional trap for double-click of the same keys
(MLDBL, MRDBL, MMDBL). The double-click can only be trapped if the
single-click is also trapped.
Script timeouts for dialog box controls
If your script defines a dialog box you are now able to use TIMEOUT and
INACTIVITY options for many DBOX controls. These have an obvious
application for buttons, where you can ’press’ the button after the specified
interval. But you can also apply them to checkboxes and radio buttons, where
you might use a shorter timeout to select given options before the button timeout
is reached.
Script Button extension
The BUTTON/SET BUTTON family of script commands has been extended to
support up to 48 buttons.
FTP improvements
Glink FTP now supports secure file transfers using either SSL or SSH. You
select the security you want in Setup / host. The configuration of SSL or SSH is
identical to the configuration of the same options in Glink.
The four gigabyte limit on file transfers has been removed. You can happily
transfer complete DVDs using the Glink FTP.
Transliteration has been added for text file transfers, both as a default or forced
for a specific file transfer. Any Glink transliteration file can be selected.
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Icons for 'Upload/Download as' (i.e. with renaming) have been added to the
toolbar.
Up/down indicators have been added to the file sorting buttons.
You can configure the meaning of a double-click on a file to be 'Open', 'Edit',
'View', 'Up/Download' (keeping name) or 'Up/Download as' (to rename). Select
the option you prefer in Settings / Files.
Options have been added to regard mainframe files with no extensions as text (as
opposed to binary) for transfer, and add or strip the .txt extension to the file
name. This is useful for some mainframes, such as GCOS8.
Glink API extensions
GlinkApi.restoreScreenContent
GlinkApi.saveScreenContent
GlinkField.isUpperCase
GlinkApi.getScreenCharacterSet
GlinkApi.flushGlinkEvent
GlinkApi.queueGlinkEvent
GlinkAPI.getGlinkEvent

restore a saved screen
save the screen (compressed)
is field restricted to upper case
obtains Glink character set name
clear event queue
use event queuing (not listener)
get event from queue

Glink packaging tool
The G&R/GLPACK tool for repacking the software for delivery of custom
installations is now provided as part of the standard software set.
Glink HLLAPI REXX support
Glink HLLAPI is extended to support REXX language interpreters. Qualified for
use with the Regina REXX interpreter
http://regina-rexx.sourceforge.net/
Facelifting enhancements
The 'fix DKU attributes' option has been enhanced to work with both 3D effects
turned on and off. By default this option is turned on to improve the visual
rendition of non SDP forms
.
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What was new in Glink 7.2?
The following new features and corrections have been added since the 7.1.0
release of Glink Professional edition (see also: What was new in release 7.1):
Glink Enterprise Edition
This release contains a completely new edition, Glink Enterprise Edition which
is licensed by number of simultaneous sessions and allows use of Glink from the
web. A Glink license server must be set up to issue session licenses.
Glink from the web
Glink Enterprise Edition includes GlinkWeb, a web mode feature, which webenables core business applications, making them available to end-users having
only a standard browser installed on the desktop. GlinkWeb requires no changes
to the mainframe applications, and no installation of workstation software other
than the browser. The Enterprise Edition also includes web controlled
workstation mode, allowing you to choose between running Glink on a web
server with a browser interface, or running Glink on the workstation, installed
by, and under control of, a web server.
The Enterprise edition includes a working demo of Glink in both web controlled
mode (in a window) and GlinkWeb (in a browser). These demos illustrate the
ease of use and simple configuration of implementing Glink from the web.
Glink license server
The Enterprise edition requires a Glink license server for issuing session
licenses. The server can be setup to run as a service or run as a foreground
process on the desktop. A monitor program is also supplied to display relevant
status information.
GlinkApi COM+ server
Both the Professional and Enterprise editions of Glink include a new thin-client
version of the GlinkApi COM+ object. This version of the API is a multithreaded out-of-process COM+ server designed for client and server application
use. All the user interface has been stripped out, optimising the object and
minimizing the footprint. This new object is automatically registered when you
install Glink and can be created using the GlinkApi.GlinkApi class name. The
normal Glink.GlinkApi objects can still be created, in which case a standard
Glink will be started.
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The Professional edition of the GlinkApi COM+ object is restricted for
development of small-scale client or server-side applications. Support of many
simultaneous sessions in a production environment requires an Enterprise
Edition license.
SSH
A new SSH comms interface has been added for communication with SSHD
daemons. This interface integrates the freeware utility called PuTTY into Glink.
The software is distributed under the MIT licence, see:
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
Security
Restricted user /R command line options have been added to disable settings and
other menus, configuration options, script startup, dial directory, file transfer,
toggles and the DSA host connection menu, see the Basic configuration
enhancements below for more details.
Use of the administrator /K option is now reserved for users with administrator
privileges.
All modules delivered in this release are now digitally signed by G&R. Right
clicking any executable and choosing Properties->Digital Signature should show
a Thawte certificate issued to 'Gallagher And Robertson AS'. If this is not
present then you are using a version that has been modified and should contact
your distributor to ensure that you have the correct files.
Codepage and language support
Codepage options for Windows fonts has been added. This provides support not
only for Latin-2 and Greek but also a number of others, for example Codepage
1250 (Eastern Europe), 1251 (Russian), 1253 (Greek), 1255 (Turkish), 1257
(Baltic), 1258 (Vietnamese), 874 (Thai), 932 (Shift-JIS) character sets.
Codepage support requires installation of NLS before use.
Support for Japanese Shift-JIS is enabled using dual-byte encoding
from the host.
The clipboard interface supports Unicode format for correct transfer.
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Script enhancements
A new facility has been added, 'learn mode'. This allows you to do a simple
'record' of your interaction with the host, and save this as a script file for future
use. The facility is accessed either through a new default button on the toolbar or
through the edit menu.
The script TRACE command has been enhanced. When this command is used, a
separate window will open when the script is executed, showing the contents of
the script file and highlighting each line of the script as it executes.
Support for Unicode script files, Windows routines are used to internally convert
to the currently active codepage before use.
Support for LF-delimited script files has been added.
New 'keys' MLDBL, MRDBL and MMDBL have been introduced in order that
double clicks may be trapped by the script ON KEY command. Note that this
will function only when the corresponding single click is also trapped by the
script.
The following new commands and variables are available:
CRDW allows you to read double-byte values from the configuration file in a
single operation
OLE ERRORS
gives control over OLE runtime error handling
PPROFILE
allows you to write values to INI-style files
RESET TURN
for resetting the ON TURN event
SET ISTATUS AUTO/SHOW/HIDE
for internet transfer status window
SET PKEY keyname
for setting the private key used in the SSH
PuTTY interface
$GLCFG
for Glink config directory
$ISTATUS
for internet transfer status
$LICENSE
gives full license text
$LICSERVER
gives license server name
$OLEERROR
gives numeric OLE error code (when available)
$PKEY
gives the current private key
Ggate enhancements
A new dialog between Ggate and Glink gives a list of available Ggate coname
and parameters configured on server now visible in the DSA/DIWS Host
configuration dialogbox for each Ggate coname. Note, this new feature requires
G&R Host Links 6.2.
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New models have been added for Ggate that allow for fully transparent eight bit
communication, the DKU9107 and VIP9800 models. This removes requirement
for SS2 usage on DKU. Note that upgrading the software at the host end will be
necessary for these models to be available.
$*$PTRN (demand turn) has been added to Ggate command menu.
Emulation enhancements
The IBM 5250 emulation has more options to control AS/400 error message
states. These include allowing any command key to reset the error state,
displaying the error messages in the status bar and suppressing the status line.
Basic configuration enhancements
Command line options can be put in a .glink file and used as a shortcut or an
URL to start Glink, e.g.:
http://myweb.com/glink/startup.web/myhost.glink
The GLINK.INI file, used for specifying default command line options, can now
be placed in the Glink directory and will be read by both Glink and the GlinkApi
server.
The following new command line options are available:
/CD configdir
/J[x] filename
/LS dnsname
/RD
/RG a,b,c
/RL
/RM p1,p2,p3
/RS
/RW
/VER update

Glink configuration file directory
Start debug mode
DNS name of the Glink license server
Disable use of debug mode
Disable predefined groups on menus (1-6)
Lock all configuration options
Disable specific menus
Has same effect as script SECURE ALL ON command
Remove Windows (system) menu
Version control option for automatic Glink upgrades

The standalone GLKEY console utility program has been replaced with GUI
transliteration table configuration directly from the keyboard options dialog.
You may now specify multiple IP addresses for all hosts. Glink will connect to
these sequentially until a successful connect is made. This applies also to the
alternate address for Ggate connections.
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Marked rectangles can now be configured to include trailing spaces when
copying them to the clipboard.
If the emulation mode permits it, you can now paste data as a block at the current
cursor position.
An option has been provided to enable numeric checking for DKU input fields
using the same limits as does the Wincom emulator.
TNVIP wait for message rather than turn, fixes problems with 'bad' TNVIP
server.
Other enhancements
This release has been qualified for use with the Windows 2003 Server family of
operating systems.
All the necessary enhancements have been added to Glink to make it Windows
XP compliant changing the visual aspects of dialog boxes and controls.
Generic FTP/HTTP access for all files, basically any file referenced by Glink
can be accessed using ftp://, http:// or https://
The Enterprise edition includes a packaging tool called GLPACK that allows
you to customize the single file setup delivery package.
The License upgrade dialogbox has now been enhanced. Licenses delivered
electronically can be pasted directly.
If the PDF documentation files are available a viewer program allows access
either directly to installed files or to the files on a CD.
The Glink setup program is now a self-extracting, self-installing package and
can include multilingual packages. The package can be customized with the
GLPACK utility.
Right mouse double click marks line, as well as current left double click for
word.
Full Latin-2 support using SS2 has been added for DKU emulations.
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The debug mode option available from the File menu and toolbar has been
changed and will now display a debug window corresponding the the /J debug
window. Debugging options have also been added to its menu, see new /J
command line options for details.
GlinkFTP
All the necessary enhancements have been added to GlinkFTP to make it
Windows XP compliant. This allows all the Windows XP look-and-feel options
to be enabled.
GlinkFTP now includes context-sensitive online help.
The default start directory is now the %HOMEDRIVE% directory rather than
the 'My Computer' drives list.
A new option to specify the 'local port' for the incoming data connection has
been added for use when running in non-PASV mode.
Log & trace options have been extended and it is now possible to configure your
own viewer when you open/edit files.
Command line options have been added for automatic transfers or to execute a
list of FTP commands from a file.
GlinkApi
Most of the enhancements to the GlinkApi have been added due to requirements
for GlinkWeb, the new web mode feature.
Amongst its requirements was the need to access the current Glink emulation
type and comms interface for special treatment depending on the result.
API access to the Ggate interactive logon parameters is now available. This is
implemented as an event that is triggered as necessary by the API when the
GlinkApi.start or GlinkApi.connect methods are called.
As the GlinkApi is 'event driven', a method for waiting for the next Glink event
to occur has been added. This allows more normal 'scripting' languages such as
VBS and Jscript to use the API easily. It is also used by GlinkWeb, as this uses
ASP server-side scripting.
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Finally, methods for accessing the comms interface in Glink directly were added.
These are mostly of use to a server-side programmer requirling direct DSA
access to the host.
Here is a full list if the methods that have been added to the GlinkApi interface:
debugStart

Start or restart Glink debugging, send output to a
file.
debugStop
Stop Glink debugging.
flushGlinkEvents
Flushes the GlinkEvent queue.
getBackgroundColor
Returns the RGB value for the given field or
character attribute.
getCommunicationProtocol Returns the current communication protocol.
getDataLength
Returns the length of the target area.
getDefaultColorAttribute Returns the default color attribute settings.
getEmulationType
Returns the current emulation type.
getForegroundColor
Returns the RGB value for the given field or
character attribute.
getGlinkEvent
Returns the first GlinkEvent available.
getInteractiveComParams Returns the interactive communication
parameters.
getVariableFieldsEx
Returns the GlinkFields object associated with
the current screen with variable fields only.
getScreenCharacterSet
Returns the name of the screen character set
configured.
GlinkKey
creates a utility GlinkKey object. This allows the
use of the GlinkKey.toString and
GlinkKey.toKey methods.
markScreenArea
This method marks the given screen area.
MessageModeBufferOverwrite
Specifies if the message mode receive buffer
may be overwritten if the limit of the buffer is
reached.
messageModeReceiveBytes
This method returns the byte array received
from the host since the last time this method or
messageModeReceive() was called.
MessageModeReceiveBytesSync
This method waits until the turn has been
received from the host and then returns the byte
array of characters received, in the host native
character set.
messageModeSendBytes This method bypasses the Glink emulation and
sends a byte array directly to the host.
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queueGlinkEvents
setGlinkDirectory
setInteractiveComParams
translateBuffer

Enables or disables the queuing of GlinkEvents.
Sets the Glink directory.
Sets the interactive communication parameters.
Translates a string between ASCII and EBCDIC.

Some new GlinkEvents have been added:
INTERACTIVE_COM_PARAMS_REQUESTED
Notifies that the Glink communication module
needs additional parameters.
PRINT_STARTED
Notifies that print has started but is not yet
available.
For more details, please refer to the "GlinkApi reference".
All the GlinkApi constants have been changed to include the class name that
uses them, e.g. GlinkKey_HOME, GlinkEvent_CONNECTED or
GlinkConfiguration_PROTOCOL_GGATE_DSA. This change avoids any
'keyword' conflicts between programming languages and constants such as the
VB/Pascal conflicts with END, LEFT, RIGHT etc.
New Glink.JS/VBS files are now included with this release. They contain all the
constant definitions described above and are automatically included into the
source object when running ScriptControl VS/VBS files.
For more details, please refer to the "Differences from the Glink for Java
version" section.
A new GlinkApi.GlinkKey method has been added to create a utility GlinkKey
object. This allows the use of the GlinkKey.toString and GlinkKey.toKey
methods.
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What was new in Glink Professional edition 7.1?
The following new features and corrections have been added since the 7.0.0
release of Glink for Windows (see also: What was new in release 7.0):
Secure Sockets Layer (SSL)
Glink can be configured to use the Secure Sockets Layer (SSL) through
Microsoft's Secure Channel (SChannel) security package to provide securityenabled communications, including identity authentication and secure, private
communication through encryption.
All currently supported versions of Microsoft Windows include SSL (SSL v2/v3
and TLS v1) and data encryption as a standard, and require no additional
software, for Windows 95 and 98, refer to the Prerequisites section for details of
how these must be upgraded to support SSL.
When a secure connection has been established, a small icon of a lock is
displayed in the status bar. If the mouse is hovered over the lock, then the
servers X.509 credentials are displayed.
GlinkFTP client
An FTP client is now provided with Glink. This runs as a free-standing program
and may be started either directly from the Glink folder, or from the transfer
menu in Glink. GlinkFTP is also integrated with Glink via the script language,
see the script enhancements section below for more detail.
User interface new-look
The basic look and feel of Glink has been enhanced to give it a 21st century
look.
The main features are the new highlighting toolbars and the possibility of
configuring a background wallpaper in the host emulation window and
surrounding it with a frame with its own wallpaper (see facelifting section),
giving a completely new dimension to old legacy applications.
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The toolbars automatically highlight as the mouse moves over them. There are
two new bars, a keyboard bar and a function bar, which contain emulation
specific buttons. All the bars can be moved and docked at the top or bottom of
the Glink window, or they can be parked partially or completely outside the
emulation window. Their last positions may be saved on exit. An option to
prevent moving of the bars is also available.
The Glink dropdown menus now contain menu-tip images. The Settings menu
menu can be configured to be a dropdown menu rather than the Win95 style
Control Panel icon box.
Facelifting enhancements
Several options have been added to provide for additional automatic facelifting
of the emulator screen. These have been grouped in a new dialog box in
Settings / Screen. They include:
Automatic conversion of function key abbreviations sent by the host into onscreen buttons.
Specification of an image file to use as a background image for the emulator
screen, and several additional options for controlling the image display.
Specification of a frame (margin) around the emulator screen.
Specification of an image file to use in the frame, and several options for
controlling the image display.
Emulation enhancements
IBM 3270 and 5250 emulations can now be used in typeahead mode.
The 5250 Field exit keys can be configured on the numeric pad in the IBM 5250
emulation options.
AS/400 error messages sent to the status line can now be configured to
automatically unblock the keyboard on the next keypress.
Script enhancements
A startup script may now be associated with a particular configuration file.
Names set in the status line with the HOST or NAME commands can now be
URLs which will work as hyperlinks.
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VBScript or Jscript files can now be started in exactly the same ways you can
start a normal Glink script, you can pass input parameters to their Main()
function and retrieve return values return values in the $GPARAM script
variable.
The OLE script command has been enhanced to work with object collection
lists.
The following new commands and variables are available:
FTP to transfer a file using FTP
MSGBOX
displays a user message in a separate window
PERFORM EDTRECALL to invoke the command recall editor
SET 3D options
to set options for 3D variables
SET DKUCOLOR
to set the DKU color mode
SET DKUMODEL
to set the DKU terminal model
SET FCLICK options
to set a clickable area in the frame wallpaper
SET FKEYBAR
controls the function key bar
SET FRAME options
to set frame wallpaper and options
SET FTP options
to set parameters for FTP transfers
SET KBDBAR
controls the keyboard bar
SET RESIZE options
to set the strategy for window resizing
SET SSL options
to set various secure socket operational
parameters
SET WALLPAPER
options to set background wallpaper and
options.
$FRAMEPAPER
provides the current frame wallpaper filename as
set with SET FRAME.
$FTP
provides the status of the current FTP transfer
$FTPADDRESS
provides the current ftp host IP address as set
with SET FTP ADDRESS.
$FTPCONFIG
provides the current ftp configuration file name
as set with SET FTP CONFIG.
$FTPDEFAULT
provides the default ftp host name as set with
SET FTP DEFAULT
$FTPERROR
provides an error message in the case of a failed
FTP transfer.
$FTPHOST
provides the current ftp host name as set with
SET FTP HOST.
$FTPMODE
provides the current ftp connection mode as set
with SET FTP NORM/PASV.
$FTPPASSWORD
provides the current ftp login password as set
with SET FTP PASSWORD.
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$FTPRESULT
$FTPSILENT
$FTPTRANSFER
$FTPUSER
$PETX
$PETY
$PSTX
$PSTY
$WALLPAPER

provides the completion code for the FTP
transfer.
provides the setting for silent ftp mode as set
with SET FTP SILENT/VERBOSE.
provides the current ftp transfer mode as set with
SET FTP ASCII/AUTO/BINARY/LOCAL8.
provides the current ftp login user name as set
with SET FTP USER.
Provides the ETX position at the time of the
most recent transmit command, in scrollback
coordinates
Provides the ETY position at the time of the
most recent transmit command, in scrollback
coordinates
Provides the STX position at the time of the
most recent transmit command, in scrollback
coordinates
Provides the STY position at the time of the
most recent transmit command, in scrollback
coordinates
provides the current wallpaper filename as set
with SET WALLPAPER.

Other enhancements
Default support has been added for WinSock2 when available. TCP/IP domain
name addresses can now be above the previous 32 character limit.
Glink internally now uses dynamic length strings. This means that some of the
254 length limits have been lifted, this includes IP Addresses, Script variables,
Script texts, etc.
When an 'inline macro' has been defined you will be asked whether the macro
should also be saved as a numbered keyboard macro or as a script file.
Editing the recall buffer is now available as a configurable internal function from
GLLAY.
The terminate on disconnect option has been extended to provide automatic
reconnection if the host connection is lost.
NETSETUP can now install icons on the desktop without creating a program
group folder.
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The option for printer selection has been extended to allow choice of a printer
the first time the printer is used in a given session.
Newer Microsoft products and operating systems now use Tahoma as the
standard font for dialog boxes. Glink has been changed to use the same standard,
but at the same time, for those who find the font more difficult to read, an option
has been added to allow selection of a larger then normal font size.
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What was new in Glink Professional edition 7.0?
The following new features and corrections have been added since the 6.2.0
release of Glink for Windows (see also: What was new in release 6.2):
New GlinkApi COM+ component
A completely new GlinkApi COM+ component has been added to this release.
The Glink for Windows API can be used from all COM aware visual
developement tools in the normal way. A complete on-line Help is supplied in
the GLINKAPI.CHM file (HTML Help format) and an Icon to reach it will
created in the Glink icon folder.
The API is visible externally as an out-of-process server and can be used from
Active Server Pages (ASP) within Microsoft's IIS. ASP support gives access to
the GlinkAPI object via the standard SESSION and APPLICATION objects
available in Active Server Pages.
The Enterprise edition of Glink (to be announced later this year) will have
exactly the same API, and execute within the MTS (Microsoft Transaction
Server) architecture as an in-process server, making Glink the perfect host access
component for your e-business applications on the Microsoft platform.
NB!! This GlinkApi is 100% compatible with the API supplied with the
Professional and Enterprise editions of Glink for Java. E-business application
developers who want a cross-platform application can easily migrate between
the Glink for Java and Glink for Windows versions of the GlinkApi.
GlinkApi COM+ source samples
Samples in Borland Delphi and Microsoft VisualBasic are supplied. They are
installed as 'read-only' files under the Glink directory in:
Samples\Delphi
Samples\VisualBasic
These examples illustrate the basic use of the GlinkApi COM+ component. To
execute these examples, you need the corresponding development tool. They
connect to live sites via the Internet, using the G&R DSA Gateway interface and
connecting to a remote G&R Ggate server (G&R Host Links product) at
"gars.gar.no".
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Automation object enhancement
The Glink's Automation object been extended with many new methods and
interfaces for handling fields, screen data, general Glink information and COM
events. This is an out-of-process server that you can start up and use from your
own applications. Any COM aware visual developement tool (Visual Basic, C++
and J++) will recognize the Glink Automation object.
The Glink Automation object can also be used within VBScript or JScript files.
You can write scripts in these standard script languages, that open and control
copies of Glink. You can launch these scripts from the desktop and from all
standard Windows applications, and integrate host access with any Office
application that can start a script.
Extra!!!
VBscript and Jscript files can be executed from the Glink 'Run script procedure'
dialog box. The script is executed directly from Glink in the same way as
running a Glink script. The script that you launch will automatically inherit as an
object the Glink that you launched it from, so that the script can take control
over the Glink that started it.
Security enhancements
More possibilities of inhibiting certain features of Glink have been added:
Inhibit changes to any of the security options
Inhibit saving of DSA login user ID and password lists
Inhibit changes to configuration options by script
Emulation enhancements
Support for 3270 Graphics has been added and can be configured in the IBM
3270 emulation options.
Script enhancements
The limitation of 64Kb for script file size has been removed, and you may now
run scripts of any size. The limitation of 32K for compiled size has been
increased to 64Kb.
The script command, SET RESOURCE, has been improved to allow you to
override one or more of the DSA/DIWS host parameters.
Gallagher & Robertson
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You can detect receiving the 'turn' from the host by using the new ON TURN
script command.
If the Microsoft Script Control is installed on your PC then Glink automatically
runs VBScript or JScript files if the file name is of the form *.VBS* or *.JS*.
The Glink.GlinkApi and Glink.Auto objects of the current session is passed onto
the script and are available under the "GlinkApi" and "Auto" names. If you don't
have the Microsoft Script Control installed, you can download it from:
http://msdn.microsoft.com/scripting/scriptcontrol/default.htm
Other enhancements
The Help / About GLINK / Update License dialog box has been
improved to allow you to update the support and phone information displayed in
the About GLINK dialog box. If you are updating the license information also,
then the netsetup.ini file will also be updated if required.
New host and local printing options have been added to allow GlinkApi
programs to intercept all print via the PRINT_DATA event.
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What was new in Glink Standard edition 6.2?
The following new features and corrections have been added since the 6.1.1
release of Glink for Windows (see also: What was new in release 6.1):
Changes that may affect the way your current Glink works
Moving from R6.1 to R6.2, the new feature to position the cursor by leftclicking the mouse is on by default, but can be turned off (see below). If you
have a release prior to 6.1 then you must search the 'What's new' section of the
Glink help for each release since the one you are using. The most dramatic
change is that the 3D option for input fields in forms was made default, and must
be turned off if not desired. If you have tested the beta release of R6.2 then the
integrated API has been removed, and will be made available in the Glink
Professional Edition release 7.0.
API enhancement
The COM/OLE model of Glink has been improved to allow access to the
emulation screen. The dual-interface COM Component and TypeLib definitions
for the Glink.Auto interface are now integrated. This makes it correspondingly
much easier to use from external programs in languages like Visual Basic, C++
and J++.
Examples of using the Glink.Auto interface can be downloaded from:
ftp://ftp.gar.no/gar/utility/glink/oleexamp.exe
oleexamp.exe Glink.Auto C++/J++/VB examples
Please note that the integrated COM component that was available in the R6.2b
beta release has been scaled down, and the complete version will not be
available until the first beta of Glink Professional (Release 7.0).
Ggate enhancements
Ggate parameters are available in the host configuration menu to allow
specification of printer connection name and printer connect to host so that these
may be supplied without resorting to using additional parameters.
It's now possible to specify the name of a script that should be run when a Ggate
connection has been established.
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Presentation enhancements
For those emulations where it's relevant, you may now move the cursor directly
to any permitted location simply by left clicking the screen. A new option allows
you to turn this off if you would prefer not to use the function.
More 3D effect options have been added to customise the variable field look and
feel. Everyone who hated the Microsoft Windows gray background we used
with the 3D option will appreciate that we now use the Glink configured
background.
The euro character is now displayed correctly for Windows fonts (so long as it is
supported in the font being used).
Line graphics are now displayed even if you are using a Windows font; they will
also always join up.
New options have been provided to allow dynamic selection of the way zero and
underline characters are displayed.
A new option has been added to provide an optional ruler to mark the current
screen position.
The context menu invoked with the right mouse button on the main screen will
now replace some of the entries that are disabled when there is no current mark,
giving new options for 'mark screen', 'print screen' and 'mail screen'.
Emulation enhancements
A wrap around tabbing option has been added to the IBM5250 emulation.
An option has been added to provide control over numeric field checking in the
IBM3270 emulation. There are many IBM applications which have specified
numeric checking on alphanumeric fields, but which work with a real terminal as
long as it is configured with a 'typewriter' keyboard (rather than data-processing
keyboard).
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Scrollback buffer enhancements
An option has been added to the scrollback edit and context menus allowing you
to delete lines that have been marked there. This allows you to be more selective
about what is retained in the scrollback. This is yet another scrollback feature for
the people who work with Glink all day, and have the scrollback as a handy
record of what they have done today. People with entire GCOS dumps in the
scrollback will now be able to retain the interesting bits.
Command recall buffer enhancements
A facility for editing the command recall buffer has been included.
Data entry field enhancements
Many data entry fields both in the setup and other menus now implement a list of
recently used data. Thus the file names you used in a number of recent transfers
are now 'clickable' as choices for the next one.
File transfer enhancements
Previously transferred file names are remembered, see 'Data entry field
enhancements' above.
An option is provided for configuring the IND$FILE command input field when
using the Transfers/File transfer menu. The default value is the field containing
the cursor.
Configuration options have been added for better paste/upload line wrapping
control.
An option has been added to allow suppression of the warning provided when a
local file already exists and is specified as the target for a file download.
Printing enhancement
AS/400 print support has been added, select the 3812-1 printer model and
specify the printer TN5250 device name to connect to.
A new option has been added to provide for interpretation of accented characters
when the host sends these in a way designed for printing on DKU attached
printers.
The status bar has been extended to show a small printer icon.
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For Ggate connections this will show whether or not there is a printer connection
active. For all interfaces the printer icon will indicate that there is print waiting
for timeout and in that case you can force immediate printer output by clicking
on the icon.
New options for printer usage allow you to force use of the printer timeout both
for host and local printing. This allows you to print output without necessarily
starting a new page for each printer job.
A new option engages logic for avoiding unnecessary blank pages on your
printer.
Basic configuration enhancements
The command line, GLWINOPT and GLINK.INI options are interpreted for
%VARIABLES%, $USER$ and $USERNAME$, allowing common icon setups
in network sharing environments, e.g. GL.EXE /U H:\$USER$\CONFIGS
Modem and printer profiles which were previously stored in the registry under
HKEY_LOCAL_MACHINE are now stored in HKEY_CURRENT_USER.
When entries are not found in HKEY_CURRENT_USER they will be copied
from HKEY_LOCAL_MACHINE in order to preserve settings from previous
releases. HKEY_LOCAL_MACHINE may still be updated by an administrator
using the /K command line switch.
Script enhancement
New built-in script variables $CX and $CY provide you with the position of the
last right mouse click, for use with the CONTEXT command.
The script DBOX command has been extended to support setting colors and
attributes for most control types.
The script DBOX command has been extended with an autotabbing feature for
edit and combo controls which have the MAXLENGTH option set.
A new script command, GETWORD, provides an easy way of collecting a single
word at a specified position in the scrollback or main screen. New script
variables $WDX1, $WDX2, $WDY1, $WDY2 and $WDL are used for
returning exact information about the word thus found.
Use of the KEYBOARD script command to load a non-existent keyboard
definition now sets the OK variable rather than abort the script.
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A hand-shaped mouse cursor may be set using the script MCURSOR command.
A new built-in script variable, $RESOURCE, provides you with the Ggate host
profile name or TNVIP resource name.
A new script command, SET BUTTON FONT, allows you to change the font
used to display texts in the button bar.
A new script command, SET MARKMODE NEW, provides more consistent
handling of the script MARK command.
A new script command, SET RESOURCE, provides a method for changing the
TNVIP resource or Ggate host profile name.
A new script command, SET DELIMITERS provides control over which
characters should be considered as delimiters when words are marked on-screen
with a double click. The associated $DELIMITER variable provides those
delimiters that are currently set. These delimiters are also used for the new
GETWORD command. A new screen setup option allows you to set defaults for
these delimiters in your configuration file.
A new script command, STITLE, lets you change the title caption for the
scrollback window. This caption is also available in the new $STITLE built-in
variable.
A new script command, URLSHOW, provides a quick and easy way of
displaying a particular URL in your default browser.
Multiple language support
Glink is now delivered with language text support for English UK and US,
French, German and Norwegian. The default language will have been set up by
your local Glink distributor. The /L command line parameter can be used to
select any specific language at run-time.
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What was new in release 6.1?
The following new features and corrections have been added since the 6.0.0
release of Glink for Windows (see also: What was new in release 6.0):
The option to turn on FORMS and TEXT mode 3D effects is now default. In
FORMS mode the presentation of fields will look like standard dialog boxes. In
TEXT mode, then a black text on a gray background is used.
NOTE: If you had not already switched this option on, then you will notice this
by the change to a gray background. If required, you can turn this option back
off in Screen/Options/3D variable fields.
Emulation for IBM5250 and IBM3151 terminals has been added.
The TN5250 interface has been added for connectivity in IBM5250 emulation
mode.
The GLLAY utility has been extended to allow customized keyboard layouts for
both the IBM3270/5250 and IBM3151 terminals.
New GLCOLS.INI file for pre-defined and configurable screen and print color
schemes. Selected and configured via the Color adjustments dialogbox.
The scrollback buffer can be configured up to 32766 pages instead of 249.
The use of Ctrl+C/Ctrl+V as Copy/Paste or as emulation keys is now
configurable for the character mode type emulations.
TCS options have been added to the DKU setup.
The toolbar and the statusbar now follow the windows configured 3D colors.
TN3270 and TN5250 protocol options have been moved from the emulation
setup to the TCP setup.
A Process marked option has been added to the right mouse floating popup
menu. This allows you to execute the associated application if it is a file name,
or start your Web browser if it is an URL.
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You may now configure either Windows printing or Direct printing, separately
for local printing or host printing. Direct printing can be Windows Passthrough
printing or Physical printing.
Both Windows 16-bit and 32-bit versions of Glink now share the same printer
setup dialog boxes.
New print options provide for specification of both vertical and horizontal
formatting.
Glink may be delivered in an unstamped form, in which case the SETUP
program will ask for the necessary Serial number information before installation
procedes.
Script termination has been added for numeric value overflow conditions.
The following script commands have been added or enhanced:
ON ENDPRINT
PERFORM KILLALL

Activates on print termination
Kills all previous G&R DSA and DIWS
sessions ('Ggate')
PERFORM LDIALOG
Displays the Local dialog menu if applicable
to the communications interface
SET DEVICE
Also sets the IBM LU device name for the
TN5250 interface
SET IBMMODEL
Added 5250 and 3151 models
SET PRINTER printer_name Allows specification of the current printer
SET RLFILTER characters
Allows specification of additional filtered
characters for the script RCVLINE
command
SET RLTERM characters
Allows specification of alternative terminator
characters for the script RCVLINE command
SET SERVER server_name
Allows specification of the server name or IP
address used in the communications
interfaces
SET TCP
TN3270 and TN5250 protocols have been
added
SET TCS
Controls the TCS mode
The following script variables have been added:
$NCOMPUTER
$NUSER
Gallagher & Robertson
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$PRINTER
$RLTERM
$SERVER

provides the current printer name
provides the terminator received with RCVLINE
provides the currently configured host or IP address

In this release, the following configuration options will be changed the first time
you load a previously generated Glink configuration file. All of them may be
modified again manually, if so, then the configuration file must be re-saved.
General / Message-based mode
turned on for less CPU usage
Communications / Option / Use notifications
turned on for less CPU usage (Win16)
Screen / Options / 3D variable fields
turned on 3D dialog box style display for
FORMS mode
Emulations / VIP options / TSM8 forms directory
if not set, defaults to 'tsm' in the Glink user's
directory

48

Glink Release Notes

Gallagher & Robertson

What’s new (6.0)

What was new in release 6.0?
The following new features and corrections have been added since the 5.4.0
release of Glink for Windows (see also: What was new in release 5.4):
The software is now available in a fully 32-bit version for Windows 95 and
Windows NT (3.5 and 4.0).
The main differences between the native 32-bit version and the 16-bit version
are:
Supported communications interfaces (fewer in 32-bit either because of
consolidation of previous interfaces or because no API is as yet available).
Windows Telephony is supported by the Win32 version in addition to those
interfaces that were supported previously (Note that the script CTYPE command
uses TAPI to set this interface, the former Excelan TELAPI interface now uses
TELAPI).
G&R GLAPI provides Glink with a link to G&R/LDSA. Light DSA is a DSA
protocol stack which can be loaded on the user PC and enables it to connect
direct to the FCP card in GCOS7/GCOS8 mainframes using DSA session over
RFC1006 in TCP/IP networks.
All communications interfaces running in the 32-bit version now run in
message-based rather than polled mode, for better use of system resources.
Direct printing is no longer supported, but is replaced with the 32-bit equivalent.
This change is reflected in the user interface for printer configuration.
Support is provided for the Intellimouse and compatible pointing devices, giving
easy access to the scrollback window and scrolling of that window.
Setup adds icons to the Glink group for all the commonly used parts of the
software, and optionally can install an icon for the program itself directly on the
desktop (first time setup only).
An uninstall utility is provided.
An initial implementation of HLLAPI is provided with this release.
TCS local forms are supported in the DKU emulation.
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Glink Release Notes

49

What’s new (6.0)
The context menus (right mouse button) in the main screen and the scrollback
now include a send mail (for marked text) option for those systems that are
MAPI-enabled.
The NETSETUP utility contains a number of enhancements to allow optional
selection of which icons to install, installation of non-Glink icons, and in the 32bit version, uninstall of the software.
The following script commands are new or enhanced:
DBOX
LINE
MARK
OLE
SET MRECT

RANGE option for numeric edit fields
MINLENGTH option for edit fields
simulates input from the host
mark an area in the current screen
OLE automation controller interface (32-bit only)
toggles the 'mark rectangles' option

The following script variables have been added:
$IPADDRESS
$MYIPADDRESS
$MWHEEL
$NT
$OLERESULT
$W32

provides IP address of current host
provides IP address of Glink machine
provides (and resets) amount of mouse wheel rotation
'1' if running under Windows NT, otherwise '0'
gives error text for OLE
'1' if running 32-bit Glink, otherwise '0'

The following pseudo keys are provided for the purpose of trapping actions
performed with the Microsoft Intellimouse and compatible pointing devices:
MMIDDLE
MMUP
MWHEEL

middle mouse button/wheel down
middle mouse button/wheel up
mouse wheel rotation

Because the 32-bit and 16-bit versions diverge slightly so far as resources are
concerned, but basically are the same in most respects, this version uses source
RC files with conditional compilation to generate resources. Translators should
contact us for source data and for up-to-date information about relevant tools
that can be used to prepare nationalized versions.
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What was new in release 5.4?
The following new features and corrections have been added since the 5.3.0
release of Glink for Windows (see also: What was new in release 5.3.0):
The following script commands have been added or enhanced:
CFXW

like CFIX, but is used for modifying two-byte
values.
DBOX
supports an optional MINIMIZE clause
SET DEVICE device_name sets the IBM LU device name for the TN3270
and TN3270E interfaces
SET IBMMODEL model_name sets the IBM terminal model for the 3270
emulation
SET IPATTERN{ON | OFF} specifies whether there should be an implied
idle period when a pattern is detected from the
line.
SET TCP TNVIP
sets the telnet protocol to TNVIP
SET TTYPE device_type sets the terminal type on telnet interfaces
(including TNVIP)
The following new internal script variables have been added:
$DEVICE
$NGLINK
$WHEN

Allocated LU name on TN3270E interfaces
Number of copies of Glink currently executing
Pattern number of most recently activated WHEN statement

A new command-line parameter, /B n, allows you to specify which LANA
number should be checked first when making NetBIOS connects. Normally this
checking will start at zero, but when multiple NetBIOS stacks are configured,
the stack over which you wish to communicate may not be the first one that's
found. An equivalent parameter has also been provided for the Windows
asynchronous modem server, GLNETW.
Support has been added for FOSSIL drivers; this support is specifically targeted
at FOSSIL drivers for ISDN cards, although it may be used for other purposes.
Support has been added for running the 3270 emulation on GCOS hosts (in
ASCII mode).
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Support has been added for extended TN3270 (TN3270E) mode, as described in
RFC1647, and as implemented (for example) in the Microsoft SNA server
running under Windows/NT. This mode provides the following features:
- support for specific LU names, which may either be configured as specific
devices or as a members of a device pool on the server.
- support for printer sessions both with SNA character stream (LU type 1) and
3270 data stream (LU type 3).
- support for both the ATTN and SYSREQ keys.
- support for the SNA positive/negative response process, especially useful for
controlling print sessions.
- support for embedded NVT data (ASCII text) as part of the data stream from
the server.
- support for SSCP-LU data messages.
A 32-bit version of the UVTI interface is available in this version. An on-line
UVTI help file (UVTI.HLP) is also provided by courtesy of Groupe Bull.
The option controlling whether or not lowercase letters should be sent to the host
has been moved from the DKU setup menu into the general emulation setup
menu, and extended to be active in all emulation modes.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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What was new in release 5.3.0?
The following new features and corrections have been added since the 5.2.0
release of Glink for Windows (see also: What was new in release 5.2.0):
For Windows '95 users, the following optional enhancements have been
included:
Full support for long filenames.
Completely revamped setup menus using an icon-based main window which in
turn accesses multiple 'tabbed' property boxes. All numeric fields have spinner
controls to allow adjustment with the mouse.
DBOX edit controls may use Windows '95 spinner controls, and a new control
type, the trackbar, is available.
Windows '95 context sensitive help; all setup menus contain the question mark
control in the caption and all options may be right-clicked for popup help.
Automatic file association for Glink script files using an extension of .SCRGL
(the currently used .SCR extension has already been reserved for screen savers).
The program has been modified to use the .SCRGL extension as an alternative in
all contexts where .SCR is used.
NOTE: Windows '95 functionality is not enabled unless you specifically request it during installation (although many features of
Windows '95 will automatically be used in any case, for example
dialog box look and feel, proportional scrollbars, etc). A copy of the
program that has been Windows '95-enabled will no longer run on
earlier versions of Windows. A small utility program
(WSTAMP.EXE) is included with the release to allow you to
change the version number in the Glink executable if you wish to
do so at some point after the initial installation.
The Ctrl/Shift/Alt+insert keys may now be reconfigured using GLLAY. Note
that Shift/Insert is not recognized by the normal DOS keyboard; use the pseudoscancode of 13 to redefine the key. The copy and paste functions normally
defined for these keys are also available for placement on other keys.

Gallagher & Robertson

Glink Release Notes

53

What’s new (5.3)
NOTE: that if you are using GLWINL.xxx keyboard definition files
where the Insert key combinations already have been defined as
something other than the default values then these redefinitions
will now be in effect, and you may need to run GLLAY again if you
wish to restore the copy/paste functionality.
GLLAY may now also be used to redefine the Enter and Return keys, either
alone or in combination with the Ctrl key. The keys are defined separately,
which allows you to define only one of the two to be a transmit key. leaving the
other as a return key (as opposed to the enter = XMT option, which maps both
keys). The tab key is also redefinable as 'simulated' scan code 2.
Emulation of the Bull DKU7102 terminal has been added.
Support has been added for the rlogin and TNVIP protocols in all TCP/IP
interfaces.
Support has been added to enable connecting to machines that are configured
behind a socks server.
The following script commands have been added or enhanced:
#IFDEF
CALC
CONTEXT
DBOX

FILTER
GWCONNECT
RATR
SERVER START
SET DBGFILE
TCKEY

can now give optional compilation based on beta release
level and validity of internal variables
calculates the result of a complex formula
allows you to add new entries to the context menus
(those invoked by pressing the right mouse button).
now provides for the possibility of suppressing the
resizing of bitmaps shown with the BBUTTON and
BITMAP commands. Under Windows '95, EDITTEXT
fields may use a 'spinner' control using the UPDOWN
control style, and a new control type is available for
trackbars.
provides for removal of selected characters from a
string.
has been extended to provide for connection through the
G&R DNTD gateways.
allows you to read physical and logical attributes from
the screen.
allows you to start a local Kermit server
allows you to change the default name of the debug file.
sends a TCU function key on the Atlantis V8 interface

The following new script variables have been added:
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$CERR
$CMDLINE
$CRECEIVE
$CSEND
$DDIR
$MRECT
$MSRECT
$SCRIPT
$WDIR
$WINSTAMP
$WINVER
$WSYSDIR

Returns position of error in failing CALC command
Provides the command line parameters used
Provides a count of characters received
Provides a count of characters sent
Provides the name of the dial directory
Allows you to test whether the screen mark is
rectangular or not
Allows you to test whether the scrollback mark is
rectangular or not
Provides the fully qualified path name of the current
script
Provides the pathname for the Windows directory
Returns version of Windows program is stamped for
Returns the current Windows version
Provides the pathname for the Windows system
directory

Three additional 'pseudo-keys' may be used in the script ON KEY command:
MLUP
MRUP
MMOVE

Left mouse button released
Right mouse button released
Mouse has moved

(these are designed for use with special-purpose applications that need to track
mouse actions with greater precision than just tracking mouse clicks).
An option allows you to specify that resizing the Glink window should change
the number of rows and/or columns in the emulator screen, rather than add scroll
bars or resize the font.
The printer auto orient option has been extended to let you choose portrait or
landscape mode irrespective of the currently set printer default. Additionally a
passthrough option is available to enable you to send host output directly to a
printer while still using the Windows output routines otherwise.
Support has been added for annotations to the scrollback buffer. These may be
attached to bookmarks or free-standing.
Using the right mouse button in the main emulator and scrollback windows
provides the most-often used functions in a floating menu.
An option has been added to enable compression of context save files.
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Renaming of colliding incoming files in Kermit has been extended.
A windows-specific version of the GLNET modem server, GLNETW, is
provided with this release of the software.
A new administrator tool for simplification of user setup in a networked
environment is included in this release.
The IND$FILE transfer protocol (DFT mode) has been implemented for the
IBM 3270 emulation. Note that you must configure as an extended terminal type
for this to function correctly (in some cases the query bit must be set in the
terminal definition in the TN3270 server).
Transliteration for the IBM3270 emulation has been extended to tackle full 8-bit
character sets in all national languages, and support Icelandic and Latin-2. If a
keyboard transliteration file of other than the DEF default is used this will be
applied after transliteration to ASCII on host data and before transliteration to
EBCDIC on terminal data.
New options have been provided for definition of printer margins.
For the Windows Sockets interface, the connect timeout is now configurable.
The Ggate interfaces have been extended with an alternate IP address, an option
for random connection, and a connect delay to specify how long to wait before
attempting to connect to the alternate. These options provide both for greater
fault tolerance and for simple load levelling. An option has also been added to
the TCP/IP setup for setting the keepalive interval on the Ggate interfaces. It's
now also possible to specify default values for interactive parameters that may
be accepted or changed by the user prior to making a connection
Defined file associations are now also used for filenames passed to Glink using
the internal escape sequence.
ANSI/VT attribute mappings are now also applied in DKU7107 mode so long as
you are set up in monochrome (1M) mode in the DKU setup menu.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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What was new in release 5.2.0?
The following new features and corrections have been added since the 5.1.0
release of Glink for Windows (see also: What was new in release 5.1.0):
An option has been added to provide greater compatibility with the form of
ANSI emulation used on many bulletin board systems.
Use of interrupt 5A on the Eicon NABIOS interface is required on this release.
A new interface which allows you to run X.25 TGX connections over the Eicon
OSI Gateway software has been added.
The Ggate interface has been modified to allow interactive entry of multiple
login parameters rather than just the password. The password parameter is
encrypted (note: the algorithm is not intended to be secure but simply to prevent
casual inspection) before being written to the GLHOST.INI file if it's saved
there.
An option has been added to the scrollback edit menu to allow manual clearing
of the scrollback buffer.
An option has been added to printer setup to allow automatic switching of
printing between portrait and landscape modes depending on the current screen
width.
An option has been added to printer setup to allow you to decide on what basis
the printer selection should apply. This can be set to always follow the current
windows printer, to start with the current windows printer but not to change in
the course of a session if the windows printer is redefined by another
application, or to apply permanently to both the current and any future sessions.
Modifiers may be specified for script variables (both standard and internal) with
a number (zero to 63) and an arithemetic operation (+, -, #, /, where # is used for
multiplication rather than the more conventional * because of a clash with the
standard comment marker). Such modifiers must be specified with no
intervening spaces. Some examples of valid syntax:
ASSIGN %var1 %var+4
POS $Y $X+2
SUBS %A %B $SCAN+1 80
IF (%1#2 ltn %2) goto LABEL
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The above functionality is for the moment provided on an experimental basis
only, and should not be used in production scripts in that it may change in future
betas.
Double-clicking an item in a DBOX list box will now terminate the dialog box
(and is considered to be equivalent to pressing the default button). A new
internal variable $DBLCLICK will however contain the number of the variable
associated with the list box that was double-clicked for those who need it. The
position of a DBOX can now be specified as CENTER.
The script WINDOW command now has an option allowing you to specify that
the Glink window always should stay on top even when not active.
A separate setup screen has been provided for selection of screen fonts. This
screen also provides more functionality than was available before.
Printer font setup has also been improved; fonts are selected from a list of
available fonts, and you may choose between automatic sizing to fill the page,
default size or any fixed size you choose.
Neither of the above improved font setup options are available for those still
running on Windows 3.0.
The internal fonts now include a small 6x4 font.
A number of corrections and improvements have been made both to the DKU
emulation and to the Ggate line interface.
A script which executes to the end of the script file will now do an automatic
RETCALL rather than a RETURN.
The capability to accept incoming calls over raw TCP/IP has been added for the
Windows Sockets interface only (this capability is basically for usage with G&R
Gmailer gateways but you are welcome to make use of it if you have an
application for it).
The GLNET and GLSPX modem servers now support ports other than COM1
and COM2, using the -B and -I command line parameters.
A new DDE poke command PosCur allows positioning of the cursor.
The new PERFORM script command gives direct access to all the internal
keyboard functions.
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An option has been added to allow suppression of circular tabbing in DKU
mode.
An option lets you choose whether VT100 application keypad mode should be
applied with or without NumLock.
Two new options, one allowing message-based operation and one enabling use
of notification messages, allow the emulator to run without the need to poll the
communications interface for input. This can produce (at least apparently) a
significant reduction in processor usage when both options are enabled. This
only works for interfaces where such notification is available from the comms
interface, currently Windows serial port, Windows sockets, and the Atlantis V8
interfaces.
You may specify that the program should terminate automatically if the
connection to the host is lost.
A new script command, SET RELINQUISH, provides control over how the
script processor allows other tasks to execute while a script is running.
An internal variable $SBKL provides the number of active lines in the scrollback
buffer. $IDLE provides the current value of the idle timer, $ROUND supplies
the rounding status, and $CASE returns the current case sensitivity.
Additionally, $IFILE and $INUMBER provide the file name and number of the
currently loaded default icon.
The context save (CXSAVE) and restore (CXRESTORE) commands now also
save the current state of script rounding, case sensitivity, and idle timing.
The clipboard with tabs may now be checked from a script using the $CTABS
internal variable, and changed with the SET CTABS script command.
Site-specific help may be added by supplying a file GLSITE.HLP in the Glink
directory. If this file is present an extra entry will be supplied automatically in
the help menu bar item.
The script DEBUG command has been extended to allow specification of user
strings for send and receive delimiters.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.

Gallagher & Robertson

Glink Release Notes

59

What’s new (5.1)

What was new in release 5.1.0?
The following new features and corrections have been added since the 5.0.1
release of Glink for Windows (see also: What was new in release 5.0.1):
Emulation of the Questar DKU7107 and DKU7211 terminals is included.
A new communications interface for G&R gateways has been included. Be
aware that the setup for this has changed to some extent since the most recent
beta version, and small adjustments to your setup may be necessary.
The default placement of the delete character key for VIP7800 and DKU7107
modes is now on the Del key rather than Ctrl/left-arrow. The DEL character will
be found on Ctrl/Del for these modes.
An option to suppress the caption has been provided.
A facility for extending the script language using external DLL libraries has
been provided.
Conditional compilation of scripts is supported using #IFDEF and associated
directives.
The 80-character limit on script variables and patterns has been increased to 255.
New script commands have been added:
ACTIVATE "Window"

Allows you to activate another application
window
GETVALUE %n "string" Allows you to convert from a binary value
GPROFILE %n "File" "Section" "Item"
Allows you to collect INI-style options from a
file
GWCONNECT %n "gateway address" "host profile"
Allows you to make a connection through the
G&R gateway
MOVEWINDOW X Y DX DY
Moves and/or resizes the emulator window
SECURE options
Allows you to remove access to possibly
sensitive data
SET BUTTON HELP n "help text"
Sets a help text for a button on the button bar
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SET CAPTION { ON | OFF }
Turns the caption bar on or off
SET INPUT { ENABLE | DISABLE }
Enables or disables input into the emulator
window
SET PROCESS { ON | OFF }
Specifies whether line input should be processed
or not
SET SHARE { COMPATIBILITY | READ | WRITE | RW | EXCLUSIVE }
Specifies sharing mode for next FOPEN
command
SET TCP { TELNET | SNI | NCR | GATEWAY | GWDIWS | GWDSA|
RAW }
Chooses the protocol to use over TCP/IP
SET TOOLBAR BUTTON n icon function
Sets the function of a button on the toolbar
SET TOOLBAR HELP n "help text"
Sets the help text for a button on the toolbar
SET TOOLBAR SIZE n Sets the number of buttons on the toolbar
A facility for incorporating bitmaps into dialog boxes has been provided (the
bitmaps may either be active or passive).
A large number of internal script variables have been implemented.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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What’s new (5.1)

What was new in release 5.0.1?
The following new features and corrections have been added since the 5.0.0
release of Glink for Windows (see also: What was new in release 5.0.0):
New items in the 'help' menu allow you to go directly to the search dialog box to
look for keywords, and also access 'help on help'.
A new entry in the 'line' menu has been added for toggling of local mode (this is
a requirement for UVTI compatibility).
A new setup dialog allows adjustment of the actual colors used on-screen.
Two new internal script variables, $FPOS(#n) and $FSEEK(#n) provide the line
number and absolute byte position in the specified file.
A new script command, FSEEK, allows absolute positioning (rather than by line
number) inside a file.
New variants of the SERVER script command allow specification of 'generic'
Kermit server commands.
The script ERASE command now accepts wildcards.
Two new button types are available for the script DBOX command, ICON
(which allows definition of a passive icon) and IBUTTON (which allows
definition of a pushbutton which has a superimposed icon rather than a text).
A new style RETEDIT may be specified for dropdown combo boxes. This style
specifies that the contents of the edit control should be returned to the calling
script rather than the currently selected item in the list box.
Two new interfaces, ICC and NetBIOS SNA, have been added on an
experimental basis and are unsupported options.
To accomodate those used to a different syntax, the optional port number in IP
addresses may now be specified using either a colon delimiter or a space
delimiter.
Choice of printer is now available as a separate entry in all 'file' menus.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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What was new in release 5.0.0?
The following new features and corrections have been added since the 4.6.3
release of Glink for Windows (see also: What was new in release 4.6.3):
IBM 3270 emulation is provided for use with TN3270.
A subset of Regis graphics is supported when running in VT-xxx modes.
The UVTI is now delivered as part of the standard Glink release.
A facility has been added for setting bookmarks in the scrollback buffer display.
A new script command, DBOX, has been added. This command brings the full
power of Windows dialog boxes to your scripts, and allows you to design dialog
boxes using almost all the different control types supported by Windows (check
boxes, radio buttons, static texts, buttons, list boxes, combo boxes and editable
texts).
An optional 'button bar' has been added to the bottom of the emulation window.
Buttons are configured using the script BUTTON command and can be
associated both with keys on the keyboard and preconfigured or dynamically
configured macros.
New SET commands have been added:
SET FONT height width

Allows you to set the font for the emulation
window
SET KERMIT LONG ON/OFFtoggles the Allow Long Packets option
SET MENU ON/OFF
turns the menu bar on and off
SET ROUND ON/OFF
controls whether or not fractional numbers
should be rounded or truncated in the script
language.
SET SCREEN WIDTH n
allows you to set the emulation screen's width
anywhere from 40 to 132 columns.
SET STS ON/OFF
turns the status bar on and off
SET TOOLBAR ON/OFF
turns the toolbar on and off
SET WARNINGS ON/OFF turns warning messages on and off
Double-clicking files in the file display will now use any associations that may
have been defined with the file manager.
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What’s new (5.0)
A new option for the VIP emulation allows you to preserve the roll mode setting
even though the application has entered forms mode and returned to text mode.
An additional 'windows-style' status line has been provided at the bottom of the
main window, leaving the normal status line to behave more like the status line
on the original terminal. This may affect some applications using scripts that rely
on reading text from the status line. The new status line may be disabled using
an option in the Settings / Screen / Window attributes menu.
A pictorial 'toolbar' may now be used instead of (or as well as) the more usual
menu items. This can be enabled by selecting the appropriate item in the system
menu.
New internal script variables have been added:
$FX
gives the current font size (X) in pixels
$FY
gives the current font size (Y) in pixels
$LASTFILE gives you the name of the last file you received (or started to
receive) with a protocol transfer.
$MSX1
Left coordinate of scrollback mark (0 if none)
$MSX2
Right coordinate of scrollback mark (0 if none)
$MSY1
Top coordinate of scrollback mark (0 if none)
$MSY2
Bottom coordinate of scrollback mark (0 if none)
(See the RSBK command for example of scrollback mark
usage)
$MX1
Left coordinate of screen mark (0 if none)
$MX2
Right coordinate of screen mark (0 if none)
$MY1
Top coordinate of screen mark (0 if none)
$MY2
Bottom coordinate of screen mark (0 if none)
(See the RSCR command for example of screen mark usage)
The capture delimiter option has been extended so as to allow passing of CR and
LF characters transparently to the capture file or print log.
An option to allow automatic tabbing for host data has been added to the VIP
setup menu.
Two new communications interface have been implemented, Unisys
InfoConnect, and the G&R SPX modem server.
An option has been added to enable compatibility with the ITT Courier and
Thomas Box 7760 emulations.
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An option has been added to allow configuration of the break key to send an
Interrupt Process packet rather than a Break on Telnet interfaces.
For Eastern Europe, support has been added for the ISO 8859-2 (Latin-2)
character set. This functionality is automatic if the Latin-2 version of the Glink
font file is used in place of the normal font file (contact your agent for details).
For Greek Windows, an optional set of fonts for the standard Greek Windows
character set has been included. Again, contact your agent for details.
Support for the public domain Ctl3D DLL from Microsoft has been added. This
module affects the appearance of all dialog boxes, giving them a more 'threedimensional' appearance. Simply place a copy of CTL3D.DLL in your Windows
system directory to enable this functionality.
The ADDMENU and BUILDMENU now insert menu items from left to right
instead of from right to left.
An additional option has been provided for initial window positioning, which
allows you to remember the current position at the end of the session and use the
same position for the next session. At the same time the position of the
scrollback window is saved. The positioning of the scrollback in relation to the
main window has also been generally improved.
Separate font choices are available for 40/80/132 column modes in the
Screen/Windows setup menu.
You may choose the initial screen width to be used for each emulation mode.
A separate configuration menu allows association of WAV sound files with
events such as file transfers and connection to the host.
An internal command has been added to stop printing and flush any outstanding
print output to the printer.
An option to disable use of PAD functionality in the X.25 interfaces has been
added.
An option has been added to suppress the use of the small dot to indicate spaces
in 7700 variable fields.
An option has been added to limit cursor movement inside VIP7700 forms.
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What’s new (5.0)
A new internal script variable, $SCAN, provides the offset into a string when the
SCAN script command is used.
The depth of the internal script stack has been increased from 10 to 20 levels.
Double-clicking may be used to mark single words in the main emulator and
scrollback windows. You may also choose whether marking is to be done with
rectangular or line-oriented marks.
The external GLDNTD program for standalone DNTD has been given a
command line option to choose which interrupt should be used.
The FOPEN command now accepts IO as a parameter to specify input-output
mode.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
In this release, support has been added for multilingual help files. These follow
the same rules as the other multilingual files, in other words you supply
additional help files GLHLPx.HLP for the language keys x you wish to support.
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What was new in release 4.6.3
The following new features and corrections have been added since the 4.6.2
release of Glink for Windows (see also: What was new in release 4.6.2):
An additional input mode for script files, EXCLUSIVE, allows for specification
of exclusive use when opening files with FOPEN.
A new script command MBAR allows specific enable and disable of all options
in Glink menus.
A new script command INCLUDE allows you to share script source code
between modules and avoid the 63Kb source limitation without resorting to
using the CALL statement.
A new script command RSBK has been added to allow reading of data from the
scrollback buffer in the same way that RSCR can read data from the emulator
screen.
A command line option (/DDE name) has been added to specify the name to be
used for DDE operations.
A new option in the printer setup menu for direct printing allows for translation
of high ASCII characters to either the PC or HP Roman character sets.
A new script command MCURSOR allows selection of the mouse cursor shape
from a script.
New script commands SET <feature> ENABLE/DISABLE allow control of use
of emulator features such as connect, disconnect, file transfer, break and
terminate.
A new script command LOG allows you to control print logging from a script.
A new script command SET DOSSHOW allows you to decide how a program
started with the DOS command will be displayed.
If a script FOPEN command fails, the script will no longer be aborted. Instead,
the OK status will be updated.
An experimental EDIT option has been added for VIP TEXT and TX-RET
modes.
Marking of text from the keyboard is now supported.

Gallagher & Robertson

Glink Release Notes

67

What’s new (4.6.3)
Internal variables $STX and $STY have been added to the script language
returning the X and Y coordinates of the start of transmission pointer (VIP7700
and VIP7800 modes only). A new variable $LINE contains the contents of the
current screen line, and $LNNO allows you to collect the number of the current
line in the source script for debugging purposes.
The maximum number of macros has been extended to 64. The maximum length
of a single macro has at the same time been extended to 255 characters. There is
still however a limitation of 650 characters total for all macros.
Synchronous cards are now supported.
Typeahead mode is now supported.
The script DELMENU command now uses an additional parameter to specify
the name of the menu to be deleted.
The script SET DECIMAL command allows you to determine the action of the
'decimal' key on the numeric keypad.
The script SET CASE command allows you to specify whether comparisons
made in scripts are to be case sensitive.
Escape sequences have been added both to the standard ANSI set and to the
command extensions to provide control over the number of lines to display onscreen.
Command extensions have been added to provide emulation-mode independent
control of printing, and also enquiry as to which emulation is running.
The script INFILE command now provides a file selection button in the dialog
box.
Keyboard and layout files may now reside in the user directory as well as the
Glink directory. Both directories will be searched, the user directory first.
The PC-NFS/RTM interface now uses the TKLIB.DLL supplied with PC-NFS
4.0 and better rather than interface directly to the RTM module. This means that
users of PC-NFS 3.0 and/or 3.5 must use the GLNFS resident program. Use of
the TKLIB.DLL reduces conflicts between different Glink windows and not
least conflicts between Glink and DOS-based PC-NFS tools running in
enhanced-mode windows.
The setting for printing of underlines in VIP mode now defaults to ON.
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The script BUILDMENU command allows you to add further entries to the
menu bar and also to provide submenus in such menus.
The script DCHANGE command allows modification of selected fields in the
dial directory from a script.
The script ICON command allows you to choose which icon should be displayed
when Glink is minimized.
The quality of print output is now selectable between default, draft and proof
modes.
The script GETDATE command can now produce ordinal and Julian dates.
The environment variable GLWIN is no longer used - the Glink directory is now
set to the directory from which the Glink program is loaded.
A script command PLAY has been added to allow playing of waveform files
from a Glink script.
In the Windows version, all script limits are automatically set to their maximum
values. The corresponding items in the general setup menu have therefore been
removed.
An installation procedure to install to harddisk from a diskette has now been
implemented.
A new network interface, the DNTD SPX Gateway has been added. This
provides the same functionality as the previous gateway interface but uses SPX
rather than NetBIOS.
The script SERVER command allows you to terminate a dialog with a Kermit
server.
The script MD and RD commands allow you to create and delete DOS
directories without having to invoke COMMAND.COM.
All currently known errors have been corrected. This includes several errors
with the GlinkBinary DDE transfer format which should now function correctly.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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What’s new (4.6.2)

What was new in 4.6.2?
The following new features and corrections were added in Glink 4.6.2:
Drag and drop of file names has been implemented for Windows 3.1. Any script
may be dropped into the main window. Other files dropped into the main
window will attempt to invoke DRAGDROP.SCR as a script; if it's found then
the file name will be delivered in the $FILE variable (if there are several names
then a file containing the names will be delivered using a @ prefix in the same
way as for the PICK command). File names may also be dropped into those
Glink dialog boxes that are asking for filenames.
Filename enquiries now use generic Windows 3.1 common dialog boxes when
Glink is run under 3.1.
Support has been added for Novell's Lan Workplace software, using sockets
directly rather than requiring the TelApi program.
Support has been added for FTP PC/TCP for Windows, using PCTCPAPI.DLL
for access to TCP/IP.
Support has been added for the Windows socket API interface, using
WINSOCK.DLL for generic access to socket libraries.
Support has been added for the Case 6500 TCP/IP interface.
Support has been added for Wollongong TCP/IP using their SOCKDOS.DLL
rather than loading GLWOL.EXE outside of Windows.
Support has been added for 3+Open Sockets using WSOCKETS.DLL for access
rather than direct access to the TSR routines outside Windows (these must
however still be loaded).
Support has been added for DEC Terminal Access using TRMNLAXS.DLL for
access either to CTERM or DEC LAT based communications.
Support has been added for PC-NFS release 4.0 using the Sun RTM.EXE
program for TCP/IP services rather than GLNFS.EXE as used in earlier versions
of the PC-NFS software.
Support has been added for multiple-language versions.
Script commands for DDE client operation have been implemented.
A script command, ADDMENU has been added which allows definition of a
user menu bar popup menu to start selected script procedures.
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A script command, MFONT has been added allowing selection of the font to be
used in user menus.
A script command WINDOW has been added allowing control of the way in
which the main window is displayed.
An internal script variable $WINDOW lets you know whether the current state
of the Glink window is normal (0), maximized (1) or minimized (2).
The line buffer display feature has been enabled for all communications
interfaces.
Format with tabs is now an option in the scrollback edit menu as well as in the
main window.
A new script command SET IDLE n sets an inactivity time to be applied after all
receives.
Two new script commands SET CAPS and SET NUMLOCK have been added
to allow toggling of these from a script.
Better support for SCO ANSI has been added to the ANSI emulation.
A host transfer command configuration option has been added (mostly for
FTRAN users). This option is also available using SET TRANSFER
COMMAND "command" in a script.
Script compatibility between the DOS and Windows versions has been further
enhanced.
Attributes used for screen erasing in ANSI mode are now selectable between
using the current screen attribute and the default attributes.
An internal version of the Zmodem protocol has been implemented, allowing
usage of Zmodem on all interfaces supported by Glink. The level of
functionality is lower than that provided by the DSZ program but should be
sufficient for most practical purposes. Those who wish to continue using the
external protocol are at liberty to do so.
Additional DDE pokes are available, VduEmu, ScrGput and Xabort. VduEmu is
similar to VduPut except that the data is treated in the same way as line data
rather than keyboard data. ScrGput sets the global script variable rather than the
local one. Xabort will abort any file transfer or dial operation currently in
progress.
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Additional DDE requests are available, ScrGget collects the global script
parameter rather than the local version delivered by ScrGet. VduFld <n>
delivers the contents of field number <n> on the current form (if <n> is not
specified then the field in which the cursor is positioned will be delivered).
The DDE LinXmt command has been extended to allow sending of data and a
terminator in the same call.
A new clipboard format, GlinkBinary, available only for DDE usage, allows
transparent transfer of data without the need for CRLF padding and allowing
embedding of ASCII NULs.
A new script command, MOK, has been added. This allows inclusion of an OK
button in a script menu that otherwise consists only of text.
A script command FLOC allows you to extract the current line number in a text
file.
You may now set up a configuration with no communications interface defined.
The GLLAY and GLKEY programs delivered with the Windows version of
Glink now default to GLWINL.DEF and GLWINK.DEF for their filenames.
A script command CONFIG SAVE allows a script to save the current
configuration.
Locking of separate options is now supported in the configuration dialog boxes.
A new internal script variable, $TITLE, allows you to extract the current
window title as set with the TITLE command.
Reading the status line using the script RSCR command may be done using a
line number of zero.
Automatic execution of a termination script has been provided for to allow
programming of an orderly exit from the program without the need to run a
script permanently in background.
All currently known errors have been corrected.
Some dialog boxes and menus have been changed and will need to be
retranslated if you are providing a foreign language version. A list is provided in
this help file for your convenience.
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Notes for users of Glink/DOS
If you have previously been using the DOS version of Glink, you will be pleased
to hear that every effort has been made to ensure compatibility between your old
Glink setup and your Glink for Windows setup. In particular, you may use your
old configuration file as a basis for your Windows configuration, your old dial
directory, your script files, and any tailormade keyboard files you may have been
using.

File names
File names have changed from GLINK/DOS.
xxx.glinkconfig Config file
GLWINK.xxx

Keyboard file

xxx.glinklayout Layout file

Configuration files
The format of the configuration file is 100% compatible between the DOS and
Windows versions. To use your DOS configuration file, copy the GLINK.CNF
file from your DOS Glink to the Glink for Windows directory, renaming it to
DEF.glinkconfig as you do so. For example:
COPY C:\GL\GLINK.CNF C:\GLWIN\DEF.glinkconfig

Dial directory
This again is entirely compatible, and uses the same file name (GLINK.PHO).
The only slight difference will be seen if you use high-ASCII national characters
in the host name and/or comments fields, in which case the different character
set used by Windows will be apparent.
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Environment variables
There is no option corresponding to 'SET GLINK=....'. Glink for Windows will
always set the Glink directory to the directory from which the program is loaded.
The option corresponding to 'SET GLOPT=...' is 'SET GLWINOPT=...'; all
parameters are accepted in the same way as for the DOS version even if not
relevant to the Windows version. Parameters may be defined on the command
line you enter when installing if you prefer

Keyboard files
A special note on character sets: the Windows version uses the Windows native
character set and this will mean that any keyboard files you have will be
incorrect in relation to high ASCII characters. The keyboard files included with
the software are however correct in relation to the Windows character set.

Script files
Although there are some minor differences between the DOS and Windows
interpretation of some of the script commands, you will find that 99% of your
scripts will run with no modification. If you have been using high ASCII
characters, then note that Glink for Windows expects these to use the Windows
character set. The special keyword OEM may be included at the start of the
script file to indicate that the script is using the PC character set, however. (the
DOS version of GLINK will ignore this keyword).
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